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 Use ADC APP to update PWM dutycycle 
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Summary 

 Required XMC kit 

 HOT Session: Key points 

 ACMP: details and connections 

 Starting DAVE 

 Work with LLD: overview 

 Work with LLD: details 

 Digital IO configuration & Alternate Functions 
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Required XMC kit 

 In this tutorial is used the XMC 
1200 Boot Kit equipped with 
an XMC1200-T038x0200 and 
Segger J-Link on-board 
debugger (OBD) 

 2 jumper cables M-F are 
mandatory 
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HOT Session: Key points 

 The target for the example of HOT session is to use the ACMP 
peripheral, in combination with a Digital IO 

 The example is made mixing the use of XMCLib by LLD and the 
APPs of DAVE4 

 The example is made in order to see the Alternate Functions 
(both as Input or Output) of each pin 

 Output of the example is the switch ON/OFF of a LED accordingly 
to the output of ACMP 
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ACMP: details [1/2] 

 In the XMC1200 there are up to 3 analog comparators. 
In this session ACMP2 will be used 

 Pins used 

 Inputs: P2.1,P2.2 

 Output: P0.5 
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ACMP: details [2/2] 
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Work with LLD: overview 

 XMC Lib consists of low-level drivers for the XMC product family 
peripherals 

 Collection of routines and data structures which covers all 
peripheral functions 

 Peripheral register abstraction by a set of stateless APIs 

set date Copyright © Infineon Technologies AG 2015. All rights reserved. Page 9 

Application code 

CMSIS-CORE 

Hardware 

XMClib 

Middleware 

DEVICE HEADER FILES CMSIS-DSP 

DAVETM APPs 



Package Description 
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 inc folder contains peripheral API header files 

 xmc_common.h: common functionality and definitions 

 xmc_device.h: device selection 

 xmc_<peripheral>.h (one header file per peripheral): Function prototypes, 
data structures and enumeration 

 xmc<family>_<peripheral>.h (optional): Family extensions 

 src folder contains peripheral API implementation 

 xmc_common.c: common functionality and definitions 

 xmc_<peripheral>.c: Implementation of common peripheral functionality 

 xmc<family>_<peripheral>.c (optional): Family specific implementation 

 doc folder contains API documentation generated from sources 

 examples folder contains extensive set of examples projects for different 
toolchains 

 

 

 

 

 

 

 

 



Package Description 
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User application 

xmc_ccu8.h 

xmc_ccu8.c 

xmc_common.h 

stdint.h stdbool.h stddef.h xmc_device.h 

XMC1300.h 

core_cm0.h system_XMC1300.h 

xmc1_ccu8.c 

xmc1_ccu8.h 

common API 
family specific  
API implementation 

xmc1_ccu8_map.h 

Connectivity device  
specific macros 

family extensions 



Coding rules and conventions 
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 C99, in addtion unions and bitfields are used for more compact 
code and data section. 

 Use only standard data types 

 Use enumerations 

 Naming convention:  

 Variables use only lower case,underscore separated words. 

 Functions use CamelCase convention. 

 Non blocking APIs. 

 Runtime error checking can be enabled by user 

 XMC_ASSERT() used to check input parameters of functions, 
result of calculations, … 

 XMC_DEBUG() used to monitor status of application 



Coding rules and conventions 
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Object = attributes + methods 

Attributes are the peripheral data struct. 

Methods are functions that take a pointer to the peripheral data 
struct as the first argument. 

 

XMC Lib uses naming conventions to bind the data struct and the 
functions that operate on it 

XMC_PERI_DoSomething(XMC_PERI_t const *peri, …); 

 

Each driver defines its own “namespace”, XMC_PERI. 

 



XMC Lib APIs 
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 Each driver has an API to get at runtime the driver version 

XMC_DRIVER_VERSION_t XMC_PERI_GetDriverVersion(void); 

 

 Each driver has an initialization function 

XMC_PERI_STATUS_t  

XMC_PERI_Init(XMC_PERI_t const *peri,  

              const XMC_PERI_CONFIG_t const *config); 

 

 Most drivers have enable/disable function 

void XMC_PERI_Enable(XMC_PERI_t const *peri); 

void XMC_PERI_Disable(XMC_PERI_t const *peri); 

 



XMC Lib APIs 
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 Event handling 

void XMC_PERI_Enable(XMC_PERI_t const *peri); 

void XMC_PERI_Disable(XMC_PERI_t const *peri); 

void XMC_PERI_EnableEvent(XMC_PERI_t const *peri); 

void XMC_PERI_DisableEvent(XMC_PERI_t const *peri); 

void XMC_PERI_TriggerEvent(XMC_PERI_t const *peri); 

uint32_t XMC_PERI_GetEventStatus(XMC_PERI_t const *peri); 

void XMC_PERI_SetInterruptNode(XMC_PERI_t const *peri); 

 

 Control 

void XMC_PERI_Start(XMC_PERI_t const *peri); 

void XMC_PERI_Stop(XMC_PERI_t const *peri); 

void XMC_PERI_Suspend(XMC_PERI_t const *peri); 

void XMC_PERI_Resume(XMC_PERI_t const *peri); 

 

 Get/setters (run time API to get or modify state of peripheral) 

void XMC_PERI_SetSomething(XMC_PERI_t const *peri, …) 

uint32_t XMC_PERI_GetSomething(XMC_PERI_t const *peri, …)  

 



Starting DAVETM for the first time  
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 Start DAVE 

 Enter path to workspace folder  

 Please chose a new workspace folder, not an existing 
workspace folder form an earlier DAVE™ version 



DAVETM CE Workspace 

set date Copyright © Infineon Technologies AG 2015. All rights reserved. Page 17 

Menu and shortcuts 

Project explorer 

App Dependency Tree 

App configuration and source code editor 

App Dependency and Connectivity 

Perspectives 



Tool Panel 
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 Generate 
Code 

 Global Interrupt 

 Pin Mapping 
Perspective 

 Report  

(Resource Overview) 

 Rebuild Active 
Project 

 Build Active 
Project 

 Start 
Debugger 

 Manual Pin 
Allocator 

 Add New 
App 

 BMI Get Set 



How to create a DAVETM CE Project [1/2] 
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 Create DAVETM Code 
Engine (CE) Project  

1. Go to File → New 
→ DAVE Project 

2. Select DAVE CE 
Project 

3. Type a Project 
Name 

4. Click  Next 

 



How to create a DAVETM CE Project [2/2] 
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 Select the appropriate 
microcontroller 

 In this case 

 XMC1200-T038x0200 

 Click Finish 

 

More optimization 
options available under 
Project Properties 



Project View 
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Work with LLD: project details [1/2] 

 XMCLib is always available in each project 

 Source files    Header files 
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Work with LLD: project details [2/2] 
LLD Code for ACMP 
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Digital IO configuration [1/3] 

 The next step for the session is to configure a Digital IO pin as 
output of ACMP2 (P0.5) by the use of relative APP of DAVE 

 Click on “Add new APP” on bottom left menu 

 Type ”digital” on Search filter field 

 Double click on DIGITAL_IO 
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Digital IO configuration [2/3] 
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 Perform right-click on App name in  
the App Dependency Tree view 

 Select Configure APP Instance 

 

 

 

 

 Second Possibility: 

 Double-click on App Name in App Dependency View 



Digital IO configuration [3/3] 

 Set pin as Input/Output 

 

 

 

 

 

 Allocate P0.5 as output by “Manual Pin Allocator” menu 
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DAVE: Generation code 

 One touch code generation 

1. Click       in the tool panel 

2. Generated code can be found under C/C++ Projects window, 
DAVE  Generated 

 

 Start Compiler tools to build the project 

 Click       in the tool panel 

 

 Ensure that Compiler finished building in Console window 
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ACMP: Hardware connections 

 Case 1:  
ACMP2.INN 3.3V  (P2.2) 
ACMP2.INP    0V (P2.1) 

 

 

 

 Case 2:  
ACMP2.INN 3.3V (P2.2) 
ACMP2.INP    5V (P2.1) 
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DAVE: Flash and Debug [1/2] 
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 Start Debug Session  

 Click       in the tool panel 

 

 Create a new Debug Configuration 

 Double-click 
“GDB SEGGER J-Link Debugging” 

 

Segger J-link Driver software 
4.96h or above needs to be 

installed 



DAVE: Flash and Debug [2/2] 
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 Hint: To switch to Project Workspace Perspective, click DAVE CE 
at upper right corner of window 

 Click “Debug” 

 The flashing process is  
started and DAVE 
automatically switches to 
Debug Perspective 

 



The Debug Perspective [1/4] 
Debug Workspace 
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Debugger actions 

Inspection controls 

Breakpoint automatically 
set in main() 

Device memory 



The Debug Perspective [2/4] 
Debug Window 
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Debug 
Session 

information 



The Debug Perspective [3/4] 
Start Program 

 Click on the Resume button to start code execution 

 

set date Copyright © Infineon Technologies AG 2015. All rights reserved. Page 33 



The Debug Perspective [4/4]  
Breakpoints 

 To place a breakpoint, double-click on the blue bar at the line of 
code 
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Debug Session 

 Select COMPARATOR in the Peripherals menu of Inspection 
controls part of Debug Perspective 

 

 

 

 

 In the Memory window will appear the registers of chosen 
peripheral 
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Debug session 

 Switching input P2.1 from “+” to “0” it is possible to see the 
change of CMP_OUT register 
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Debug Session 

 Outputs of CMP_OUT 

 P2.1 connected to “+” 

 

 

 

 

 

 P2.1 connected to “0” 
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Debug Session 

 The P0.5 doesn’t change its status. Why? 

 It is not set as ACMP2. OUT!! 

 

 Each pin has many functions, called Alternate Functions 

 In every Reference Manual, it is present a table which describe 
this characteristics 
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Alternate Functions 
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Alternate Function: how to configure 

 Step 1: change perspective to DAVE CE and open the 
digital_io_conf.c file with double click 
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Alternate Function: how to configure 

 Step 2: Change the conf mode of the DIGITAL_IO from 
XMC_GPIO_MODE_OUTPUT_PUSH_PULL to 
XMC_GPIO_MODE_OUTPUT_PUSH_PULL_ALT6 
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Alternate Function: how to configure 

 Step3: Re-Compile the code without any Re-generation of 
code 

 Step4: Flash and Debug 

 Step5: P0.5 works accordingly with the output of ANACMP 
peripheral 
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PWM to Blink an LED  

 Creation of a PWM signal that control a LED 

 

 

PWM 
- CCU4 -  

P0.0  

PWM 1Hz  

duty-cycle 50% 
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CCU4 
Modular Timer Approach 

 Equal structure and same availability of features for each of the 4 Timer Slices 

 Functions controllable via external signals do not depend on the selected signal 

 Portability of code is not dependent on the used Timer Slice 

 High amount of configurable external functions (11), make each Timer Slice a 
very flexible HW resource for signal conditioning  
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CCU4 
Flexible PWM generation 

 Each Timer Slice of the 
CCU4 can operate in 
center aligned or edge 
aligned mode 

 Additional operation 
modes like single shot, 
counting or dithering 
modes are also available 

 Update of the Duty Cycle 
and Period can be done 
on-the-fly to 
accommodate different 
operation requirements 

 Additional external 
controllable functions 
give another degree of 
PWM manipulation (e.g. 
timer gate, timer load, 
timer clear, etc)  



Learning Outcome 

 Learn the basic principles of DAVETM: 

 Required XMC kit 

 Create DAVETM Project  

 GUI based DAVETM APPs configuration 

 Graphical pin mapping 

 One touch code generation 

 Download and debug code 

 DAVETM updates 

 Expert support 
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Add DAVETM APP from Code Repository 

 Add DAVETM APP to project 

1. Click      in Tool Panel, or  

2. DAVE → APP New APP 

3. Type “PWM” in the search 
filter field, and double-click 
PWM APP 
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 All APPs included in the Project are displayed in different views: 

 

 

 

 

 

 The number behind “_” identifies the instance of an APP 

More Project Views 
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DAVETM APPs Editor View 

 Either  

1. Right-click APP name in 
the App Dependency Tree 
view 

2. Select Configure App 
Instance 

 

 Or 

 Double-click APP name in 
the App Dependency view 
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PWM APP Configuration 

 Configure PWM APP via graphical user interface editor 

1. Set PWM Frequency to 1 Hz 

2. LED blinks every 0.5 second 

3. Check “Start Timer After Initialization” 
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Rename the Instance Label of the PWM APP 

 Right click on the PWM APP 

 Select  
Rename Instance Label… 

 Type in: MyLED 

 

 Now “MyLED” can be used as 
handler in the APIs of the 
PWM APP to reference this 
instance 
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 Reference to DAVETM APP 
information 

1. Double-click DAVETM APP 
(e.g. PWM_0) in App 
Dependency View 

2. Click Help icon 

 

Hint: Additional Information about APPs 
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Pin Mapping for PWM App (1/2)  

 Assign signal to pin with 
graphical pin mapping 
view 

1. Click     to open Pin 
Mapping Perspective 

2. Under Virtual Pin 
List, select PWM 
Output Pin 

― Green pin: All possible 
pins for selected signal 

― Blue pin: User 
assigned pin 
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 To unassign pin: 

 Right-click on a blue pin → 
Unassign 

 

 To assign pin: 

 Right-click on a green pin → 
Assign 

 

 

 

 

 

 

 

Pin Mapping for PWM App (2/2)  
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 Assign PWM Output Pin to User LED1 at P0.0, #17 

 Right-click on pin 17 → Assign 

 In case you  use a different board /  device please select a pin that is connected to a LED 

 



Hint: Check Correct Resource Mapping 

 Check resource mapping 

 Click       to open 

Reports in DAVE CE                 
perspective 
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 One touch code generation 

1. Click       in the tool panel 

2. Generated code can be found 
under C/C++ Projects window, 
DAVE  Generated 

 

 Start Compiler tools to build the 
project 

 Click       in the tool panel 

Generate Code and add a few Lines of Code to change the 
Duty Cycle of the PWM and Compile Code 
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Check Compiler Results 

 Ensure that Compiler finished building in Console window 

Page 65 2014-05-05 Copyright © Infineon Technologies AG 2014. All rights reserved. 



The Project Folder 

Generated code goes in here 

Compiler output files  

Linker Script file 
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App Code Templates, Manifest 

Folder which is used exclusively by DAVETM 

CMSIS, Low Level Drivers 



 Ensure the Debugger of the XMC 1200 BootKit is connected to 
your PC via USB 

 

Flash and Debug (1/3) 

Debugger 

Micro USB 
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XMC1200 

Microcontroller 



 Start Debug Session  

 Click       in the tool panel 

 

 Create a new Debug Configuration 

 Double-click 
“GDB SEGGER J-Link Debugging” 

 

Flash and Debug (2/3) 
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Segger J-link Driver software 
4.96h or above needs to be 

installed 



 Hint: To switch to Project Workspace Perspective, click DAVE CE 
at upper right corner of window 

Flash and Debug (3/3) 

 Click “Debug” 

 The flashing process is  
started and DAVE 
automatically switches to 
Debug Perspective 
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The Debug Perspective (1/6) 
Debug Workspace 
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Debugger actions 

Inspection controls 

Breakpoint automatically 
set in main() 

Device memory 



The Debug Perspective (2/6) 
Debug Window 

Debug 
Session 

information 
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 Click on the Resume button to start code execution 

 

 

 

 

 

 

 User LED1 (P0.0) on XMC1200 BootKit board should be blinking 

The Debug Perspective (3/6) 
Start Program 
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The Debug Perspective (6/6) 
End Debug Session 

 Always end a debug session by clicking the Terminate Button  

Page 73 2014-05-05 Copyright © Infineon Technologies AG 2014. All rights reserved. 



Agenda 
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PWM to Blink an LED  

 Add ADC Measurement APP to read potentiometer, then update 
PWM dutycycle when ADC is ready. 

 

 

PWM 
- CCU4 -  

P0.0  

PWM 1Hz  

duty-cycle 50% 

ADC 

Interrupt 
 

GetResult() 
Set DutyCycle 

P2.5 

End Of 

Measurement 



ADD ADC_MEASUREMENT APP 
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Configure ADC_MEASUREMENT APP [1/2] 
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 Enable Continuous conversion 



Configure ADC_MEASUREMENT APP [2/2] 

 In “Measurements” 
Change name from 
“Channel_A” to 
“Potentiometer”  

 

 

 

 

 In “Interrupt setting“ 
Set “Enable end of 
measurements 
interrupt” 
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Generate Code and add a few Lines of Code to change the 
Duty Cycle of the PWM 

 One touch code generation 

1. Click       in the tool panel 

 ADD this code 

 

 

 

 

 Start Compiler tools to build the project 

 Click       in the tool panel 

 Start Debug Session  

 Click       in the tool panel 
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 DAVETM APPs and device support can be updated locally 

 Re-installation not required 

 

 Update DAVETM system  

 Help → Check for Updates 

 

 Update DAVETM APPs and device support 

 Help → Check for DAVE App Updates 

 

One-click DAVETM update  
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Expert Support  

 Easy access to DAVETM technical support, downloads and 
information updates 
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DAVETM Forum 
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